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1 The user manual and the 
software 

1.1 THE USER MANUAL 
This User manual must be red carefully and completely prior to anyone using the 
equipment. 

The User manual is designed as an educational guide and reference tool for 
anyone who wishes to use the SDT 170 MD equipment and the software 
DataManager for its intended purpose. 

SDT produces this manual with the sole purpose of supplying simple and 
accurate information to the user. SDT shall not be held responsible for any miss-
interpretation of this manual. Despite our efforts to provide an accurate manual, it 
may contain technical errors beyond our control. If in doubt, contact your local 
SDT distributor for clarification. 

While every effort was made to present a true and accurate text, modifications 
and/or improvements to the product described herein can be made at any time 
without corresponding changes being made to the manual. 

This User manual and its content remain the inalienable property of SDT. 

1.2 THE SOFTWARE 
Neither the company SDT International, nor any related company, will in any 
circumstances be liable for any damages, including, without limitation, damages 
for loss of business, business interruption, loss of information, defect of the 
DataManager software, bodily harm, loss of time, financial or material loss or any 
other indirect or consequential loss arising out of the use, or inability to use this 
product, even when it has been warned of possible damages. 
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1.3 TRANSLATION 
This manual has been translated from French.  

In the event of conflict between the French version and any version translated 
into a foreign language, the French version takes precedence over any other 
language and must be referred to for any question concerning the relationship 
between the parties.  

Any translation of this manual into any foreign language is done only for reasons 
of convenience and as reference. 
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2 Introduction 

DataManager is a software application operating in the PC environment. It is 
exclusively designed to work closely with an Ultrasonic Detector of type 
SDT 170 MD; a specific manual is devoted to the functionalities of SDT 170 MD. 

Once installed, the DataManager application is used in the following manner.  

Step 1: before taking measurements on the points of the site 

● Creation of routes for one or more SDT 170 MD (up to 128 routes can be 
transferred simultaneously in an SDT 170 MD). 

● Definition of each point of measurement of the route (types of measurement, 
alarm thresholds, linked files - audio, image or other). 

● Transfer of the PC routes to SDT 170 MD. 

 
Creation of routes and points; transfer of information to be collected to SDT 170 MD of the 
operator. D950 

Step 2: taking measurements on the points of the site 

● Memorizing data measured by SDT 170 MD according to parameters 
defined in the preceding step with the DataManager application (the routes, 
points and measurements to be collected are displayed on the screen of 
SDT 170 MD of the operator). 

 Note: this functionality is specific to SDT 170 MD and not to the 
DataManager application. 



 

Recording of measurements by the senso

Step 3: after measurements are tak

● Transfer of the measured data of

Transfer of measurements of SDT 170 MD

Step 4: analysis of measurements 

● Visualization of data collected by
or reports and possible editing. 

● Consultation of alarms of th
corrective actions. 

Step 5: backup of data 

● Possible data backup stored by
external storage medium (USB, b
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rs connected to SDT 170 MD. D952 

en on the points of the site 

 SDT 170 MD to the PC. 

 
 to the DataManager application of the PC. D953 

taken on the points of the site 

 SDT 170 MD in the form of tables, graphs 

reshold excesses detected for possible 

 the internal data base in the PC on an 
ackup on server, on external disc, etc.). 
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3 Quick familiarization 

3.1 OBJECT OF THIS CHAPTER  
DataManager application is software with many functionalities. These 
functionalities were developed to best fit with professionals’ expectations. You 
will certainly use these functionalities to meet your new requirements and will be 
pleased to know that they are already available in the different menus. 

Initially, you may want to quickly familiarize with the DataManager application and 
use its basic functions, reserving the study of advanced functions for a later 
phase. 

This chapter helps you discover DataManager application by means of a step by 
step guide. After reading this chapter, you will be autonomous and will be able to 
proceed with the complete reading of the manual and discover the advanced 
functions of the DataManager application.  

At the end of this chapter you will know how to:  

● Install the DataManager application on your PC. 

● Create a route. 

● Create the points of measurement of the route and define alarms. 

● Transfer data from your PC to SDT 170 MD using serial connection (RS232) 
or USB. 

● Recover data from SDT 170 MD and transfer them to your PC using serial 
connection (RS232) or USB. 

● Consult measured data (values, alarms, graphs). 
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3.2 INSTALLING THE SOFTWARE ON THE PC 
Follow the instructions of paragraph 4.2, on page 23. 

3.3 LAUNCHING THE DATAMANAGER APPLICATION  
Step Screen Explanatory note 

1  Launch the DataManager application 
 

 

Select Start/Programs/DataManager and click 
on the DataManager icon. 
Note: during this step, the SDT 170 MD does not 
have to be connected. 
PP00 

2 

 

When the error message is displayed, click 
on OK without taking any notice of this 
message; SDT 170 MD is not yet connected 
at this stage. 
PP01 

3 

 

The application is displayed. 
PP03 

4  Select the working language 
 

 

Select Options/Language. 
Select the appropriate choice in the 
displayed list and click on OK. 
PP04 

  The following procedure will define a route.  
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3.4 CREATING A ROUTE 
Step Screen Explanatory note 

1  In the menu bar, select Route/New.  
2 

 
Enter the password (SDT by default). Click 
on OK. 
To modify the password, see § 13.3.2, page 93. 
PP05 

3 

 
PP06 

The Route parameter setting window opens. 
- Name: Enter a route name (maximum 12 

characters) describing the route. Do not use 
special characters such as space, 
underlined, etc). 

- Description: enter the route description 
or comment (maximum 255 characters) if 
necessary. 

- Author: enter the name of the author 
(your name) of this procedure if necessary. 

- Creation date: modify the date if necessary. 
- Click on OK to confirm the entered data. 
The route is created. The route name is 
indicated at the bottom of the window. 

  The following procedure will define the points of 
measurement of this route. 
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3.5 CREATING THE POINTS OF A ROUTE 
Step Screen Explanatory note  

  Create the point of measurement 
1  

 
 

 
PP07 

Open the route whose points are to be 
created as follows: 
- In the menu bar, select Route/Open. 
- Click on the route for which points are to be 

created (the route created in § 1.1 in this 
example). 

- Click on OK. 
Logically, this step is not necessary since the 
route is already active as indicated at the bottom 
of the screen. However, it is a good practice to 
select the route to be used. 
Note: a route called “000” is already present. Do 
not delete it. 

2  - In the menu bar select Edit/Points/Single 
editing. 

3 

 

- Click the Insert button. 
PP08 

4 

 
PP09 

Define the name of the point: 
- Name: enter the name of the point (12 

characters). 
- Description: enter the description of the 

point (maximum 50 characters) if necessary. 
- Comment: enter a comment relating to the 

point (maximum 255 characters) if necessary. 
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  Define the alarm thresholds of the point 
5 

 

Click on the Add button.  
 

6 

 
PP10 

Enter the threshold values: 
- Sensor type: select from the drop-down list 

the sensor type of this point. 
- Thresholds method: allow the Danger/Alarm 

option. 
- Threshold 1: key in the first threshold (lower 

threshold). 
- Threshold 2: key in the second threshold 

(higher threshold). 
Click on OK. 

7 

 

The pre-set alarm thresholds are displayed in 
the Thresholds zone. 
To add another threshold using another type of 
sensor present on this same point of 
measurement, restart the procedure from step 5. 
If no other threshold is to be defined, click on 
OK.PP11 

8 

 

The point of measurement is visible in the Route 
points window. 
PP12 
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9 

 

To create a new point of measurement on the 
route, restart the steps from step 3 onwards. 
If no other point is to be created, click on Close.  
Note: to print this data, see item 7 on page 21. 
PP12 

10  The following procedure will transfer data to SDT 
170 MD. 

3.6 TRANSFERRING INFORMATION TO SDT 170 MD 
Step Screen Explanatory note 

 
 

Connect the PC to the SDT 170 MD 
1 

 

Activate the SDT 170 MD by pressing on . 
The SDT 170 MD main menu is displayed. 

2  Connect the SDT 170 MD to the PC. 
  Serial link (RS232) 

Connect the delivered plug ended cord between 
the serial COM1 port of the PC and the 
connector of SDT 170 MD. See figure on 
page 24. 

  USB connection  
If your PC is not equipped with a serial port 
(RS232), follow the procedure described on 
page 99 before continuing. 
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  Transfer data to SDT 170 MD 
3  In the menu bar select Transfer/To 

SDT 170 MD. 
 

 

A window shows the progress. 
In the event of connection problems see 
page 97. 
PP13 

4 

 

In the window click on . 
The SDT 170 MD displayer indicates Remote 
control. 
PP14 

5 

 

Select the route to be downloaded in SDT 
170 MD in the left corner of the window. 
Click the To SDT 170 MD button. 
PP15 

6 

 

Click OK when the download is complete. 

Click to unlock the connection. 
Close the window opened in step 5 by 
clicking on Close. 
PP16 

7  The SDT 170 MD connection with the PC can 
be disconnected. 
The SDT 170 MD can now be used to take 
measurements on the route and at the points 
defined in paragraphs 3.4 and 3.5. 

8  The DataManager application can be closed. 

9  Once measurements on site are complete, the 
following procedure will transfer data collected 
by SDT 170 MD to the PC. 
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3.7 TRANSFERRING INFORMATION TO THE PC 
Step Screen Explanatory note 

 
 

Connect the PC to the SDT 170 MD 
1 

 

Activate the SDT 170 MD by pressing on . 
The SDT 170 MD main menu is displayed. 

2  Connect the SDT 170 MD to the PC. 
  Serial link (RS232) 

Connect the delivered plug ended cord between 
the serial COM1 port of the PC and the SDT 170 
MD connector. See figure on page 24. 

  USB connection  
If your PC is not equipped with a serial port 
(RS232), follow the procedure described on 
page 99 before continuing. 

3  If necessary, launch the DataManager 
application (see § 3.3, on page 12). 

  Transfer data to the PC 
4  In the menu bar select Transfer / 

To SDT 170 MD. 
 

 

A window shows the progress. 
In the event of connection problems see 
page 97. 
PP13 

5 

 

In the window click on . 
The SDT 170 MD displayer indicates Remote 
control. 
PP20 

6 

 

Click on the Start button. 
PP21 
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7 

 

Click OK when the download is complete. 

Click  to unlock the connection. 
Close the window opened at step 5 by 
clicking on Close. 
PP22 

8  The SDT 170 MD connection with the PC can be 
disconnected. 

9  The following procedure will use the Analysis 
menu of the DataManager application to 
visualize the data collected by SDT 170 MD. 

3.8 ANALYZING THE INFORMATION 
Step Screen Explanatory note 

 
 

Select the route to be visualized 
1  In the menu bar select Routes/Open. 
2 

 
Enter the password (SDT by default). 
Click on OK. 
PP05 

3 

 

Select the route to be analyzed and click on OK. 
PP25 
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  Display the alarms 
4 

 
PP30 

This function displays alarms as well as the 
values measured according to the criteria 
defined here.  
In the menu bar select Analyse/Alarms.  
- Level: choose the level to be displayed. Both 

display the set values of the first and the 
second threshold. All displays all the values.

- Date: select the period for which the values 
are to be displayed. 

- Sensor: select the alarms display for all types 
of sensors (All) or only for one type of sensor 
selected in the drop-down list Only one. 

- Sort by: select the sort criterion. 
- Linked files: if necessary, click on one of the 

files linked to the point of measurement. 
As of selection, the contents of the table are 
updated. 

  To view the measurement curves 
5 

 
PP35 

This function displays the curves for the selected 
points on a maximum of 3 graphs. Each graph 
can display measurements of several points of 
the same type of sensor or 2 different sensors.  
In the menu bar select Analyse/Curves. 
- Name of the point: select the point to be 

displayed.
- Sensor type: select the sensor type to be 

displayed on this point (a point can have 
several sensors).

- Date: select the period for which the values 
are to be displayed. 

- Bar graph/Time graph: a bar graph displays 
the graphs in the form of histograms. The time 
graph displays the data in the form of curves. 

- Work with: select the graph on which the 
curve will be drawn. 

Click on Add to display the graph. 
When selected, the graph is updated. 
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  Display the values 
6 

 
PP40 

This function displays measurements for the 
selected point. 
In the menu bar select Analyse/Values.  
- Name of the point: select the point of the 

route whose measurements are to be 
displayed.

- Date: select the period for which the values 
are to be displayed. 

- Linked files: if necessary, click on one of the 
files linked to the point of measurement. 

When selected the contents of the table are 
updated. 

  Display the characteristics of a route 
7 

 
PP45 

This function displays the characteristics of each 
point of the route, points entered as described in 
paragraph 3.5.  
Caution: this function requires the Excel 
application on the PC. 
Select Analyse/Route to display the data in 
an Excel window.  
This data can then be printed. 

You now have the major functionalities of the DataManager application.  

We advise you to continue reading this manual to the end and discover other 
functions. The index at the end of the manual will help you quickly find the 
required information. 
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4 Installation 

4.1 HARDWARE AND OPERATING SYSTEM REQUIREMENTS 
DataManager will run on any PC that uses the Windows 2000 or Windows XP 
operating system. The minimum hardware requirements to install DataManager 
are:  

● Windows 2000 or Windows XP with 256 Mo RAM.  

● A CD-ROM Drive. 

● At least 150Mb of free space on your hard drive. 

● An available serial link (RS232) to connect the SDT 170 MD to your PC. The 
link will be done thanks to a RS232 cable delivered with the equipment. 

 Note: if the PC does not have an (RS232) serial link, use a USB/RS232 
adapter (see page 99). 

4.2 INSTALLING DATAMANAGER 
Installation of the software is standard. Insert the CD-ROM into your drive and 
wait while your PC searches for the installation commands. 

 

Should the automatic install fail to initialize, start the "Setup.exe" 
program by double clicking the icon on the CD ROM.  

 

 

A folder named DataManager is created in the Start / Program 
Files menu.  

The Setup.exe contains the shortcut icons for the main file 
Datamanager.exe and the help file Datamanager.hlp. 
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4.3 LINKING (RS232) THE SERIAL PORT OF THE PC TO THE 
SDT 170 MD 

Proceed as follows: 

1. Push the On/Off button  (rep. 2) on the SDT 170 MD; the main 
screen is displayed (rep. 1). 

2. Connect the connector (rep. 4) to the serial COM port COM1 of the PC. 

3. Connect the connector (rep. 3) to the SDT 170 MD. 

 
Connecting the cable between the SDT 170 MD and the PC. D001 

 
If your PC does not have an (RS232) serial link, a USB/RS232C 
adapter will have to be used. Refer to page 100 for this connection 
procedure. 

4.4 UNINSTALL DATAMANAGER 
To delete the DataManager application, proceed as follows: 

1. Select Start/Parameters/Control panel/Add-delete programs. 

2. In the displayed list, search for the SDT DataManager line. 

3. Right click on this line and click on Modify/Delete button. 

4. When asked to delete, click Yes to all. 

5. Once the deletion is complete, select the Program Files directory 
(generally on the C: drive). 

  Save the contents of the Data directory if necessary. Then delete the 
SDT DataManager directory. 

6. DataManager application is completely removed. 
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5 Launching DataManager 

 
It is assumed that the SDT 170 MD has been correctly connected to 
the PC and switched on, as described in the previous chapter. 

5.1 LAUNCHING THE PROGRAMM  
Select the icon named DataManager in the Start/Programs/DataManager menu. 
Once the start-up screen is automatically closed, the following window is 
displayed. By default, the menus are in English. 

 
The main screen of the application is displayed in English during the first use. 003GB 

5.1.1 Error messages on launching the application 
In the event of a connection or configuration fault, an error message will be 
displayed on launching the application. 

Cause 1: no cable or SDT 170 MD not connected 
If the SDT 170 MD equipment could not be detected, one of the following 
messages is displayed: 

● « Cable is not present or not correctly connected ».  

● « SDT 170 MD is probably off ». 

● « Port xx doesn’t exist ». 

Click on OK to erase the message. Before continuing, it is highly recommended 
to find out why this message was displayed (connection fault, defective cables, 
equipment off-line, run down battery, etc). Although it is possible to work with the 
software, the transfer between the PC and the equipment however will not be 
possible 
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A faulty connection can be due to the selection of a bad COM port. Proceed as 
follows: 

● From the main screen, select Options / Parameter. 

● Select the tab COM/port (next figure). 

● Enter the correct COM port number used and click Close.  

 
Selecting the COM port of the PC. 63D 

Selection of the COM port via file “DataManager.ini”  

If the procedure described above does not work, use the following procedure:  

1. In the work station open Program files and Datamanager. 

2. Double click on DataManager.ini (file type: Configuration file). 

3. Modify the COM No=1 line with any other port number (for example 2). 
Save the modifications and close this file.  

4. Relaunch DataManager. 

Cause 2: Port x is already used by another application 
This message is displayed when the COM port is already used by another 
application or equipment or if the port is already active during the attempt to 
relaunch the DataManager application. 

Close the message window displayed and work on the second window. However, 
communication with the SDT 170 MD will be possible only after selection of 
another communication port (Options/Parameter, COM/Port tab).  



5. Lauching Datamanager 
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5.2 SELECT THE WORKING LANGUAGE 
It may be necessary to select the working language of DataManager. Select 
Options/Language; click on the suitable option and then on OK. The menus are 
then displayed in the selected language. 

5.3 THE MAIN SCREEN  
The main screen is displayed. The accessible menus are detailed in chapter 6. 
The type of unit connected can be determined by choosing the drop down menu 
Options / Detection SDT 170 MD. 

 
The main screen of the application. 003 

The main screen allows access to all the functions of the DataManager software. 
The displayed information is: 

● Bottom left corner: the version number of this software.  

● Bottom center: name of the route. 

● Bottom right corner: SDT 170 MD type (if a SDT 170 MD is connected), the 
version number of this software, the route name and the COM port used or 
the message “No SDT 170 MD”. 

 
The lower corner of the window displays the version of the application, name of the route 
(000 by default), the detector type (SDT 170 MD) and the COM port used.  

DataManager opens the last route used during the preceding session. The name 
of the active route is displayed in the central lower corner of the main screen. 
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5.4 DISPLAYING THE INLINE HELP 
Select the menu Help and Contents or click on the button Help in the 
corresponding window.  

5.5 DISPLAYING THE DATAMANAGER VERSION 
Select the menu Help and About to display the version number of the software.  

5.6 PASSWORD 
For any first entry, the password is required in: 

● One of the sub-menus of the Route menu, except for the sub-menus Open 
and Linked files.  

● The Edit menu.  

Enter the password and click OK.  
The default password is “SDT”.  

Refer to paragraph 13.3.2- Parameter - Security Tab to modify the default 
password.  

 
The window asks for the password. 210 

If, without entering a valid password, Cancel or OK is clicked, only searching of 
data will be possible. No modification will be possible. 

5.7 EXITING THE PROGRAMM 
In the File menu, Select Exit. 
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6 The menus 

This chapter introduces the main functions of the software. Each menu is 
exhaustively described in the corresponding paragraph. 

 
General view of all the menus. M0  

6.1 FILE 

 
The File menu. M1  

Item Description See § 
Backup 
database 

Transfer of all information of the data base 
(DDB) of the DataManager application to a 
compacted file of type ZIP. 

11.6.1 

Incremental 
update 

Merging of data from a ZIP save of 
DataManager in the current data directory.  

11.6 

Send to Excel Immediate transfer of data displayed in the 
screen exclusively to the Excel ® application, 
which must be installed on the PC.  

- 

Exit Closing the application.  5.7 
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6.2 ROUTE 

 
The Route menu. M2  

Item Description See § 
New Creation of a new route.  7.1 
Open Selection of a predefined route for viewing or 

modifying.  
7.2 

Rename New name for an existing route.  7.3 
Linked files Selection of files (texts, images, audio, video, etc) 

linked to the current route.  
7.5 

Delete Removal of an existing route. 7.4 
Export Export of the data in a predefined format (ASCII, 

MIMOSA, DBF).  
7.7 

6.3 EDIT 

 
The Edit menu. M3  

Item Description See § 
Parameter Similar to the Route/New menu (modification of 

information of description, author and creation date of 
the active route) except for the modification of the 
route name. 

7.1 

Points Single edit. 9.1 
 Global edit from Excel. 10 
Thresholds Single edit. 9.2.1 
 Global edit from Excel. 9.2.2 
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6.4 TRANSFER 
The sub-menus are accessible only if an SDT 170 MD is correctly connected to 
the PC. 

 
The Transfer menu. M4 

Item Description See § 
To SDT170 MD Data transfer from PC to the SDT 170 MD. 11.4 
From SDT 170 MD Data transfer from SDT 170 MD to PC.  11.5 
Synchronize Date/time synchronization of the SDT 170 MD 

with the PC. 
11.3 

Delete Purging the entire memory of the SDT 170 MD.  11.2 

6.5 ANALYSIS 

 
The Analysis menu. M5  

Item Description See § 
Alarms Displaying alarms for the current route.  12.4 
Curves Displaying measurements in graphical format.  12.5 
Values Displaying measurements in spreadsheet format.  12.3 
Route Displaying current route information in an Excel 

window. 
12.6 
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6.6 OPTIONS 

 
The Options menu. M6  

Item Description See § 
Language Selection of the language used in windows.  13.1 
Unit Selection of the measuring units of the metric or 

imperial system.  
13.2 

Parameters Definition of four parameter groups of the 
DataManager application: name of the company 
(for editing purposes), password, localization of 
the data base, COM port used on the PC and 
icons used in the alarms tables.  

13.3 

Detect 
SDT 170 MD 

Run a communication between the software and 
the SDT 170 MD.  

13.4 

Empty DB Purge old data from the data base.  13.5 

6.7 WINDOW  

 
The Window menu. M7  

Item Description 
Cascade Windows displayed one under the other, in cascade. 
Tile Windows displayed in mosaic form.  
Close all Closing of all the open windows.  
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6.8 HELP 

 
The Help menu. M8  

Item Description 
Contents Displaying of on-line help.  
About Displaying the software version number.  
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7 Definition of the routes 

A new route enables definition of the points of measurement to be assigned to 
the route. Route 000 is displayed by default when the DataManager 
application is launched. 

 
DataManager automatically creates a bulk route 000. This route is 
intended to allow temporary storage of measurements for periodic 
checks on machines that are not part of a pre-defined route. Do not 
delete this route. 

If a password is requested, see paragraph 5.6. 

The Route menu groups functions relating to routes management. 

The Route menu groups functions relating to routes management. M2 

7.1 CREATING A NEW ROUTE  
To create a new route, proceed as follows: 

1. Select the Route menu and click on New. 

2. Enter information as follows: 

 
The screen when creating a new route. 211A 
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● Name: a name (maximum 12 characters) which describes the route.  
 Do not use special characters such as space, underlined, etc. Choose this 

name carefully, since it is the key word used by DataManager to ensure 
proper sorting of data.  

● Description: description of the route or a comment up to 255 characters in 
length. 

● Author: name of the author of this procedure (optional). 

● Creation date: the date the route was created. The date is entered manually 
or selected in the pop-up calendar, clicking on the arrow ▼. 

 
The completed window of a new route. 211B 

3. Click OK.  
The route is created if the same name does not already exist.  
The route created is now available in the Route/Open menu (see paragraph 
7.2). 

 
An unlimited number of routes can be created by the 
DataManager application. However, a maximum of 128 routes 
can be transferred simultaneously to an SDT 170 MD. 

7.2 OPENING A ROUTE  
Proceed as follows to open an already created route (see § 7.1):  

1. Select the Route menu and select Open. 
A window shows a list of available routes.  

2. Select the desired route. 

3. Click OK.  
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The name of the current route appears now in the lower central corner of the 
main window.  

 
The screen when choosing an existing route. 221A  

7.3 RENAMING A ROUTE  
Proceed as follows to rename an already created route (see § 7.1):  

1. Select the Route menu and select Rename. 
A window shows a list of available routes.  

2. Select the desired route and click the OK icon. 

3. Enter the new name (maximum 12 characters) and click on OK.  
A message warns that modifying the name of the route will create a new 
route in the database during the process of next transfer of data to the 
SDT 170 MD. 

 Click OK. 
The new name is now available, provided Cancel was not clicked. 
Note: before renaming a route, please transfer the data from SDT 170 MD to 
the PC (see paragraph 11.5) and purge the memory of SDT 170 MD (see 
paragraph 11.2) in order to avoid having two routes of different names 
having the same points. 

7.4 DELETING A ROUTE  
Proceed as follows to delete an already created route (see paragraph 7.1):  

1. Select the Route menu and select Delete. 
A window shows a list of available routes.  
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2. Click OK. 
A message "Are you sure to delete…" is displayed.  

3. Confirm the deletion by selecting Yes or cancel the request with the No 
button.  
The route is deled if Yes has been clicked. 

7.5 LINKED FILES  
7.5.1 Purpose of linked files 
The DataManager application enables linking of files (audio, video, image, text, 
etc) to a route and/or a point, in order to provide additional information 
(localization, presence of danger alerts, particular instructions, etc) which will be 
displayed in the Analysis menu screen. 

These files will be read by applications associated by default; the applications 
can be of any type accepted by the Windows environment, such as image 
(JPEG, BMP), audio, video, etc. 

7.5.2 Creation of links 
Links are created in 2 steps: 

● Step 1: put the (audio, video, images) files in the Linked Files folder of the 
DataManager application. 

● Step 2: manually connect the files of the Linked Files folder (created at step 
1) to the route concerned. 

 
The linked files will link to the route currently selected and displayed at 
the bottom of the window. 

240B 
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These two steps are carried out as follows: 

1. In the Windows explorer, select C: /Program Files/SDT 
DataManager/Linked Files. 

2. Drag the appropriate (audio, video, image) files in this folder. 

3. Close these windows. 

4. In the DataManager menu bar, select Route/Open (see paragraph 7.2) to 
select the route on which these files will be linked. Close this window. 

5. In the DataManager menu bar, select Route/Linked files. 

6. In the linked files window, select on the top corner files concerned by the 
route (multiple selections possible) and click on Add link. The files will be 
associated with the active route from now onwards. 

 To delete a link, select the files concerned in the lower corner and click on 
Remove link. 

 

Files usable 
for all the 
routes. 
 
 
 
Files  specific 
to the selected 
route. 
 

Activation of linking of a file “001.JPG” file (lower corner) is now linked to the active route. 240C 

7.6 PRINTING A ROUTE  
Refer to paragraph 12.2. 
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7.7 EXPORTING 
Data relating to each or several points can be exported into one of the three 
formats ASCII, Mimosa or DBF to have data which can be imported in a specific 
application. 

● Ascii: the data is exported in a text file format, in a listing presentation (one 
line per measurement), with or without header (name of columns, with fields 
separated by tabs or without header (name of columns).  

● Mimosa: the data is exported in a text file format, one line per data, several 
lines per measurement.  

● DBF: the data is exported in a format compatible with the data base files.  

7.7.1 Exporting in ASCII format  
Proceed as follows: 

1. In the menu select Route / Open and select the route(s) to visualize 
(use the CTRL key) and click OK. 

2. Select Route / Export and select the export format ASCII. 

3. In the Export data window displayed, select the point(s) to be exported. 
Use Caps or Ctrl keys for multiple selections. 

 261A  
The selection screen for exporting to ASCII format. 261A 

4. Select the date limits to be exported (From and To). 

5. Click Writing header to have the name of column exported (Name, 
Sensor, Date, Time, Value, etc.). 

6. Click Show file to have the exported file display at the end of the 
procedure) with the application Notepad. 

7. Click Export to export the file. In the new displayed window, enter the 
name of the exported file and select the directory. 
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8. Close the windows. 

 
The resulting window of export to an ASCII format.  261B 

7.7.2 Exporting in Mimosa format  
Proceed as follows: 

1. In the menu select Route / Open select the route(s) to visualize (use the 
CTRL key) and click OK. 

2. Select Route / Export and select the export format Mimosa. 

3. In the Export data window displayed, select the point(s) to be exported. 
Use Caps or Ctrl keys for multiple selections. 

 
The selection screen for exporting to Mimosa format. 262A 

4.  Select the date limits to be exported (From and To). 

5. Click Show file to have the exported file display at the end of the 
procedure (windows type txt) with the application Notepad. 

6. Click Export to export the file. In the new displayed window, enter the 
name of the exported file and select the directory. 

7. Close the windows. 
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The resulting window of export to MIMOSA format. 2 622B 

7.7.3 Exporting in DBF format  
Proceed as follows: 

1. In the menu select Route / Open, select the route to be visualized 
(using CTRL key) and click on OK. 

2. Select Route / Export and select the export format All data to DBF. 

3. Select the directory where the files will be created and click OK. 
Three files (points.dbf, routes.dbf and vals.dbf) will be created in 
the specified directory. 

 
The window for DBF format export.  263A 
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8 Definition of the points of a route 

Each route is comprised of up to 1000 points (0 - 999). Each point can be defined 
and/or modified to suite the needs of the route. All 1000 points need not be used; 
however, they are there for future expansion of the route as required. 

8.1 HOW TO PROCEED 
The SDT 170 MD is a multi-functional measuring tool capable of storing data 
from several different sensors (i.e., the rotation speed measurement, 
temperature measurement, and ultrasonic measurement can be taken for one 
point). 

Each type of measurement can be stored in the SDT 170 MD and transferred to 
the DataManager software. 

Defining a route means establishing the points of the route, their relative position 
within the route, and the type of measurements to be assigned to each point. 

The procedure of the parameter edition of the route will then consist of: 

● Entering the procedure by selecting the Parameters menu. 

● Entering the name of the point to be created. 

● Selecting the type of measure (dBµV, temperature, etc) and alarm 
thresholds. 

 
Important: any modification or encoding of one, or several points 
within the DataManager software, must be transferred to the SDT 170 
MD hardware prior to the next measuring campaign (see Chapter 11 – 
Transferring the data). 

8.2 INDIVIDUAL OR GLOBAL MANAGEMENT 
The present version of DataManager enables in addition the management of 
points in the following manner: 

● Individual, by definition of the characteristics of a point (see chapter 9, page 
45). 

● Global, by definition of the characteristics of several points at the same time 
(see chapter 10, page 61). 
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9 Individual management of points 

This method makes it possible to define the characteristics of each point of 
measurement of a route individually.  

Note: it is possible to define the characteristics of several points simultaneously 
(refer to chapter 10, page 61). 

The Edit menu groups functions relating to management of the points of 
measurement and the alarm thresholds of a selected route. 

The “Edit” menu groups functions relating to points and alarm thresholds. M3 

9.1 MANAGING THE POINTS OF A ROUTE  
Reminder: parameters of a route can be modified only if the route is open (see 
paragraph 6.2). Look up the status bar in the central lower corner of the screen to 
verify the name of the active route.  

If a password is requested, see paragraph 5.6. 

 
The active route is displayed in the lower central corner of the screen (here ROUTE01). . 

Proceed as follows: 

1. Select the Edit menu and click on Points and select Single editing. 
The Route points window is displayed. It presents all functions usable within 
the framework of management of points of measurement of a route. 
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The window allows modification or creation of points on the active route. 310B 

The available functions are:  

Function Purpose See § 

Insert  Add a new point. 9.1.1 

Edit  Edit an existing point to read or to modify its 
parameters. 

9.1.2 

Delete 
measurements  

Erase all historical measurements of the point. 9.1.3 

Delete point  Erase the selected point and all its related 
historical measurements. 

9.1.4 

Move up Move up the position of the selected point in 
the list. 

9.1.5 

Move down Move down the position of the selected point in 
the list. 

9.1.6 

Rename Rename the selected point. 9.1.7 

Print  Accessible only after selection of a point trough 
Edit / Points. 

9.1.8 

Important: see also paragraph 9.3 relating to the easy copy/past of data 
relating to points. 
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9.1.1 Inserting a new point  

 
Before entering the various points of the route, it is advisable to define 
precisely the real order position of each measuring point, in order to 
simplify the collection of measurement. 

This function enables creation of a new point of measurement. Click on Insert 
(preceding paragraph). The following screen is displayed.  

 
Edition screen of a point. 310C 

Enter the data as requested, by selecting with the mouse, the desired field to 
enable:  

1. Position field: enter the position of the point.  
The position is the number or order in which the points are displayed on the 
screen of the SDT 170 MD while following the route.  

2. Name field: enter the name of the point.  
A maximum 12 characters is allowed. This name can not be modified for an 
existing point.  

3. Linked files button: to link files (image, video, audio) relating to this 
point.  
In the Linked files opened window, select the files to be linked to the point 
and click on Add link. Close the window. 
Reminder: the linked files available in this window have been defined in 
paragraph 7.5.2, page 38. 
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Files usable 
for all the 
routes. 
 
 
 
File specific 
to the 
selected 
route. 
 

Example of linked files screen. The file “001.jpg” is linked to the currently active point. 310D 

4. Description field: enter the description of the point.  
A maximum of 50 characters is allowed. 

5. Comment field: enter a comment concerning this point. 
A maximum of 255 characters is allowed.  

 
Example of definition of a point. The thresholds zone is described below. 310E 
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6. Click on the Add button to enter additional alarm data relating to the 
measurements. 
The screen is as follows. 

 
The screen defining the type of measurement and alarm levels.  310F 

Four pieces of information are required. 

● Sensor type: select the sensor type to be used for this point in the drop-
down list.  

● Thresholds method: defines the type of alarm release (Danger/Alarm at 
two levels or Right/Wrong). 

- Warning/Alarm: Threshold 1 (Warning) is set off when the 
measurement is equal to or higher than the value defined in the field 
Threshold 1 and lower than the value defined in the field Threshold 2.  

 Threshold 2 (Alarm) is set off when measurement is equal to or higher 
than the value defined in the field Threshold 2.  

 The Warning/Alarm option corresponds to the normal use of the alarm 
thresholds. 

 
Alarm levels in the Warning/Alarm thresholds method.  321D1 



 
 

50 

- Right/Wrong: an alarm is activated when measurement is equal to or 
outside the Low limit (Threshold 1 field) and High limit (Threshold 2 
field).  

 This option is generally used to carry out a fast validity check of a 
measurement which must be located between two predefined values 
(range of accepted values).  

 
Alarm levels in the Right/Wrong method.  321D2 

 

● Threshold 1: enter the lower level of alarm; the unit will be automatically 
displayed, for example dBµV, according to the selected sensor.  

● Threshold 2: enter the higher level of alarm; the unit will be automatically 
displayed, for example dBµV, according to the selected sensor.  

 
Recall of the screen defining the type of measurement and the alarm thresholds.  310F 
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7. Click OK to confirm. 
The Alarm thresholds window is closed and the Thresholds zone of the 
Editing a point window is modified. 

 
The “Thresholds” zone displays the information entered in the “Alarm thresholds” window. 310G 

To delete one line of the threshold values click on the line to be deleted and 
then on the Delete button and OK when asked.  

8. Click on the OK button to close the screen. 
The Route points screen contains now the new point. 

 
This window is now fitted with the new point. 310H 
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9.1.2 Editing a point  
This function allows modification of the characteristics of a point previously 
created (see paragraph 9.1.1). Proceed as follows: 

1. In the menu bar, select Edit and click Points and click Points and 
Single edit. 
The Route points screen is displayed. 

2. Select the point to be modified. 

3. Click Edit. 
Modify the data (see paragraph 9.1.1). 

4. Click OK. 
The point works now with the new data. 

9.1.3 Deleting the measurements  
This function allows deletion of the measurements (selected data) of the point 
concerned. However, the linked files and the definition characteristics of the point 
will not be cleared. 

1. In the menu bar, select Edit and click Points and Single edit. 
The Route points screen is displayed. 

2. Select the point whose measurements are to be erased. 

3. Click on Delete measurements. 

4. Click Yes to delete or No to cancel. 
If Yes is clicked, the point measurements are deleted. 

9.1.4 Deleting the point  
This function allows deletion of an already created point (see paragraph 9.1.1). 
Please note that deletion of a point deletes all the historical measurements and 
associated links. Proceed as follows: 

1. In the menu bar, select Edit et click on Points and Single editing. 
The Route points screen is displayed. 

2. Select the point to be deleted. 

3. Click Delete point. 

4. Click Yes to delete or No to abort. 
If Yes has been clicked, the point is now deleted from the list. 
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9.1.5 Moving up a point  
This function allows modifying the numbering of the point by increasing its order 
number at each click. The position of the point in the displayed list corresponds 
to the number or order in which the points will be displayed on the SDT 170 MD 
while following the route.  

     
The point 3 (left screen) has been moved up after clicking on the Move up button (right 
screen). 321S1-S2 

9.1.6 Moving down a point  
The position of the point in the displayed list corresponds to the order number or 
order in which the points are displayed on the screen of the SDT 170 MD while 
following the route. 

This function allows modifying the numbering of the points by decreasing its 
order number at each click. This function is similar to the previous paragraph. 

9.1.7 Renaming a point  
This function allows the modification of the name of a point through a window. 
Enter the new name and click on OK. 

 
The modification window contains only one field, avoiding so the modification of other 
parameters.  321R1 
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9.1.8 Printing a point  
This function prints data relating to the point of physical measurement. The Print 
button is accessible only after selection of a point in the list. Proceed as follows:  

1. In the menu bar, select Edit / Points and Single edit. 
The Route points screen is displayed. 

2. In the left list, select the point to be printed. 

3. Click Print. 
The screen displays the main information. 

4. Use the button as follows. 
 (See next page). 

Icon Description 

 
Displays first page. 

 
Displays previous page. 

 
Displays next page. 

 
Displays last page. 

 
Print. 

 
Define the printer parameters. 

 
Close the printing screen. 

 
The window before printing.  321I1 
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9.2 MANAGING THE ALARM THRESHOLDS SEPARATELY  
9.2.1 Modifying the alarm thresholds of only one point  
This function is accessible by Edit/Thresholds/Individual Editing. It enables 
display of the different points of the route and the associated alarm thresholds. It 
has the same functionalities as the window displayed by the menu bar 
Edit/Points/Individual Editing/Edit (see page 49, step 6), but does not allow the 
deletion of an alarm. 

Thus, the use of this window is mainly dedicated to a rapid browsing of alarm 
thresholds. 

Proceed as follows to add or modify an alarm threshold. 

1. In the menu bar, select Edit, Thresholds and Single edit. 
The Alarm thresholds screen is displayed.  

 
Example of an alarm thresholds screen. 331A 

2. Select the point(s) to be modified. 
  If this point has one or more alarms, these are displayed in the lower corner 

of the window. 

3. Select the Sensor type in the drop-down list. 

4. Select the Thresholds method to be used. 
 The principle of the thresholds method is described in pages 49 and 50. 

5. Enter the new thresholds to be applied to the selected point by ticking 
on the check boxes before entering the numerical value.  

6. Confirm by clicking on Apply.  

7. Click on Close. 
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9.2.2 Modifying the alarm thresholds of several points  

 
This can be used only if the PC on which DataManager is launched 
has the Excel application. 

This function, accessible by Edit/ Thresholds/Global editing with Excel, allows on 
the one hand, visualization of all the points of measurement of the active route 
and the associated alarm thresholds, and, on the other hand, the modification of 
values on several points of measurement, manually or from a macro Excel for 
example.  

Caution: the alarm thresholds of a point or several points can be modified freely. 
However, it is not possible to add a point of measurement and its characteristics 
in this Excel window. Use beforehand, from the menu bar, the functions 
Edit/Points/Single edit and the button Insert (paragraph 9.1.1, on page 47) or 
Edit/Points/Global edit with Excel (chapter 10, on page 61). 

Proceed as follows: 

1. In the menu bar, select the route to be processed by Route/Open. 
Select the route to be edited and click on OK 

2. In the menu bar, select Edit / Threshold / Global edit from Excel.  
 The Excel application is automatically launched and the window displays the 

thresholds of the points of measurement defined in the route. 

 
The points and the alarm thresholds are displayed in the Excel application. 332A 

 
Modification of the points (addition, deletion, modification) of the route 
in Excel is detailed in chapter 10, on page 61. It is thus not possible 
to add, modify or delete points from this window. 

 

 ROUTE ID: do not modify column (A). A new route cannot be created in this 
window; use the function Route / New of the DataManager application. 

 POINT ID: do not modify the name of the point in column (B). A new point 
cannot be created in this window; use the function Edit/Points of the 
DataManager application. 
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 SENSOR TYPE: enter here, if necessary, the new type of sensor.  
 Caution: the label must be identical to the list present in the Alarm thresholds 

window (see page 49, point 6). Strictly comply with the case of the label. The 
following table lists the usable descriptions. 

Label Description 
Contact Contact probe. 

RPM Tachometer (turns per minute). 

Temperature Standard temperature sensor. 

Temp. IR Infrared temperature sensor. 

Decibel A Sonometer. 

FLow Mass air flowmeter (air leak). 

Parabolic Parabolic sensor. 

Open 10 mm Open ultrasonic sensor of Ø 10 mm. 

Open 16 mm Open ultrasonic sensor of Ø 16 mm. 

Closed 8 mm  Closed ultrasonic sensor of Ø 8 mm. 

Closed 18 mm  Closed ultrasonic sensor of Ø 18 mm. 

Int.Sensor Ultrasonic sensor of the SDT 170 MD. 

Ext.Sensor External ultrasonic sensor. 

 

 Threshold 1: modify, if necessary, the alarm threshold 1 value. 

 Threshold 2: modify, if necessary, the alarm threshold 2 value. 

 Warning/Alarm method: insert, if necessary, the “star” (*) sign or leave the 
box blank  

- *: the Warning/Alarm method will be used (see page 49). 

- blank: the Warning/Alarm method will not be used. 

 Right/Wrong method: insert, if necessary, the “star“ sign (*) or leave the 
box blank  

- *: the Right/Wrong method will be used (see page 49). 

- blank: the Right/Wrong method will not be used. 

3. Once the values are modified, close the Excel application 
IMPERATIVELY. 

 IMPORTANT: DO NOT PROCEED to save the Excel window by the 
File/Save or File/Save as menu; the modifications would not be taken into 
account by DataManager. 
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4. Click on Yes when the window displays Do you want to update the 
data base with the Excel data? 

5. On the menu bar Edit/Thresholds/Single editing, by selecting the point, 
it is possible to visualize the modifications made in step 1. 

9.3 COPYING AND PASTING DATA 
To simplify the entering of data relating to one or several points, a copy/past 
function is useful. It permits copying data between points of a same route or 
between two different routes.  

9.3.1 Copying and pasting data in a same route 
Proceed as follows: 

1. Select Edit/Points/Single edit. In the Route points window select the 
line to be copied with the left button and then right click on this same 
line. 

2. Select Duplicate (and not Copy) in the pop-up menu. 

 
The pop-up menu is displayed. 321CA 
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3. In the new window automatically displayed, enter the name of the new 
point (not yet created at this stage) which will receive the data of the 
original point and click OK. 

 
The name of the point to be copied is defined in this dialog box. 321CB 

4. In the Route points window, click right button and, select Paste in the 
pop-up menu. 

 
The selection of the Paste function. 321CE 

5. The new point is added to the list with its new position number.  

 
The new point is added to the list. 321CF 
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9.3.2 Copying and pasting data between two different routes  
The way is similar to the previous paragraph. Proceed as follows: 

1. In the Route points window, right click on the line to be copied (or on 
different lines by using the Ctrl key). 

2. In the displayed pop-up menu, select Copy (and not Duplicate). 

3. Close the window. 

4. Open a new route, selecting from the menu bar : 

- either Route/New (enter the description of the new route) and OK. 

- either Route/Open, select the route and click OK. 

5. Select Edit / Points / Single edit. 

6. In the Route points window, click right and select Past. 
 The point or the points copied in step 2 are added. If necessary, the point 

numbering is automatically modified.  
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10 Global management of points  

This method allows creation, update or deletion of points of the active route from 
an Excel application. Excel must imperatively be installed on the PC supporting 
the DataManager application. 

The advantage of this method is that all the data of the points of the route are 
visible on the spreadsheet and modification is done by copy-paste or by a macro 
designed by the user according to his requirements. 

 
The list of points is directly visible in the Excel application. 322A 

Reminder: it is possible to individually define the characteristics of each point of 
measurement (refer to chapter 9, page 45). 

10.1 OPERATING PROCEDURE 

 
This can be used only if Excel is installed on the PC on which 
DataManager is launched. 

10.1.1 Displaying points in Excel  
Proceed as follows:  

1. In the menu bar select Route/Open. Select the route to be edited and 
click on OK. 

2. In the menu bar select Edit / Points / Global edit from Excel.  
 The Excel application is automatically launched and the window displays the 

current points of measurement defined on the route. 
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The points are displayed in the Excel application. 322A 

 
The modification of the alarm thresholds in Excel is detailed in 
paragraph 9.2.2, page 56. 

10.1.2 Managing the list of the points in Excel 
Proceed as follows to modify, delete or add points. 

Modifying one or more points 
1. In the Excel window displayed, modify the desired values in the 

corresponding cells.  

 ROUTE ID: do not modify column (A). A new route cannot be created in this 
manner; use the function Route/New of the DataManager application. 

 POINT ID: do not modify the name of the point in column (B). To modify the 
name of the point, define the new name of the point in column “C” called 
New Point ID. 

 NEW POINT ID: enter in the column “C”: 
- The new name of the point for an already existing point; 
- Or the name of the new point to be created. 

 ORDER: modify, if necessary, the order number of the point (order of display 
of the points of measurement on the SDT 170 MD). 

 DESCRIPTION: modify, if necessary, the description of the point of 
measurement. 

 COMMENT: modify, if necessary, the comment relating to the point. 

 To delete:  

 - * (star): the complete line will be deleted in the data base. This point will 
no longer exist. In this case, it is advised to modify the order numbers of 
column (D). 
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 - blank: the line will not be deleted in the data base. It will be replaced by 
the possible modifications made in this line or saved if no modification has 
been made. 

2. Once the values are modified, close the Excel application 
IMPERATIVELY. 

 IMPORTANT: DO NOT PROCEED to save the Excel window by the 
File/Save or File/Save as menu; the modifications would not be taken into 
account by DataManager. 

3. Click on Yes when the window displays Do you want to update the 
database with Excel data? 

4. By selecting the point and clicking on Edit in the menu bar 
Edit/Points/Single edit, it is possible to view modifications made in 
step 1. 

To delete one or more points  
1. In the Excel window displayed, click in the column (G) “Delete” the line 

corresponding to the point to be deleted.  
 Do NOT delete the line directly by Edit/Delete from the Excel menu; the 

deletion would not be taken into account. 

2. In the column (G) of the point to be deleted, enter the value “ * ” (star). 
For deletion, it is advised to modify the order numbers of the column (D). 

 

Write * (star) in the 
cell of the line of the 
point to be deleted. 

Writing of the “ * ” (star) value in column (G) of the line corresponding to the point to be 
deleted. 332D 

3. Once the values are modified, close the Excel application 
IMPERATIVELY. 

 IMPORTANT: DO NOT PROCEED to save the Excel window by the 
File/Save or File/Save as menu; the modifications would not be taken into 
account by DataManager. 

4. Click on Yes when the window displays Do you want to update the 
data base with the Excel data? 



 
 

64 

5. By selecting from the menu bar Edit/Points/Single edit, deletion of 
points done in step 2 can be viewed. 

Adding one or more points  
1. In the Excel window displayed, click in a blank cell under the last 

occupied line.  
 In the example below, the click was carried out in the cell (A8). 

 

Click in an empty 
cell. 

Click in a blank cell to begin the addition of a new point.  322M 

2. Enter successively the following data: 

 ROUTE ID: enter imperatively the same name as that present in this column. 
A new route cannot be created in this manner. 

 POINT ID: strictly leave this cell blank.  

 NEW POINT ID: enter in the column (C) the name of the point to be added 
(see figure below). 

 

Enter imperatively 
the new name in 

column (C). 
 

Entry of the new name in column (C). Column (B) remains obligatorily blank.  322N 

 ORDER: enter the order number of the point (order of display of the points of 
measurement on the SDT 170 MD). 

 DESCRIPTION: enter, if necessary, the description of the point of 
measurement. 

 COMMENT: enter, if necessary, the comment relating to the point. 
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 To delete: leave the cell blank; the line will be added in the data base.  

3. Once the values are modified, close the Excel application 
IMPERATIVELY. 

 IMPORTANT: DO NOT PROCEED to save the Excel window by the 
File/Save or File/Save as menu; the modifications would NOT be taken into 
account by DataManager. 

4. Click on Yes when the window displays Do you want to update the 
Database with Excel data? 

5. By selecting from the menu bar Edit/Points/Single edit, addition of 
points done in step 2 can be viewed. 
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11 Transferring the data  

Once a route has been created within the DataManager software (refer to 
Chapter 8 – Definition of the points of a route), it must be transferred to the 
SDT 170 MD to be used. 

If a route, point, or position is modified within the DataManager software, the new 
route must be transferred to the SDT 170 MD to be used.  

 
1. Before any modification in the DataManager application, it is 
imperative to transfer measurements from the SDT 170 MD to the PC. 

2. After any modification in the DataManager application, it is 
imperative to transfer the route data from the PC to the SDT 170 MD 
before any new measurement. 

The communication procedures (transfer, removal, synchronization) are 
managed by the Transfer menu.  

 

The “Transfer” menu groups the major communication functions. M4 

11.1 CHECKING OF CONNECTION 
Note: the SDT 170 MD must be connected to the PC.  

- By a serial link (RS232) (see paragraph 4.3, page24). 

- Or by a USB link (see 15, page 99). 

Before transferring from or to the SDT 170 MD, check that the detector is 
correctly connected to the PC by selecting from the Options / Detect 
SDT 170 MD menu bar. 
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This function allows the detection of the SDT 170 MD. 64A 

If the SDT 170 MD : 

● is correctly recognized (correct connection, detector set on), the progress 
menu bar displays detection and the DataManager application can 
communicate with the SDT 170 MD.  

 
The progress bar. USB10 

● is not recognized (cable not connected, detector off), an error message 
announces the defect. Refer to chapter 14, page 97, for details.  

 
Example of error message. Er_02 

11.2 PURGE THE MEMORY OF THE SDT 170 MD 
The DataManager application can completely purge the memory of the SDT 170 
MD. This is done in the instance of an error (for example an error by the user) 
during the monitoring procedure.  

Proceed as follows:  

1. Connect the SDT 170 MD to PC (serial or USB port) and press . 

2. Check the PC-SDT 170 MD connection, in accordance with § 11.1. 

3. In the menu bar, select Transfer and Delete.  

4. The message Are you sure you want to delete all? is 
displayed. 
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5. Click: 

- No to abandon the procedure. 

- Yes to erase. The SDT 170 MD displays Remote control until the end of 
the purge procedure. The DataManager application confirms that the 
memory is purged. Click the OK button to restore the unit to normal 
running mode.  

11.3 PC - SDT 170 MD TIME STAMPING SYNCHRONIZATION  
This function allows the time stamping synchronization of the SDT 170 MD with 
the PC. Proceed as follows: 

1. Connect the SDT 170 MD to PC (serial or USB port) and press on . 

2. Check PC-SDT 170 MD connection, in accordance with § 11.1. 

3. In the menu bar, select Transfer and Synchronise.  

11.4 TRANSFERRING THE ROUTES TO THE SDT 170 MD  
The application DataManager is capable of managing an unlimited number of 
routes. Any 128 of those routes can be transferred to the SDT 170 MD, along 
with historical data for a defined time period. The transfer operation includes 
three steps: 

● Transfer of all existing data of the SDT 170 MD to the DataManager. 

● Preparation the routes to be transferred to the SDT 170 MD. 

● Effective transfer of the routes to the SDT 170 MD. 

Note: the SDT 170 MD must be connected to the PC.  

-  By a serial connection (RS232); see paragraph 4.3, page 24. 

-  Or by a USB connection; see chapter 15, page 99. 

Warning: this function transfers firstly all the routes and their data from the 
SDT 170 MD to the DataManager software. 

Proceed as follows:  

1. Connect the SDT 170 MD to PC (serial or USB port) and press on . 

2. Check the PC - SDT 170 MD connection in accordance with § 11.1. 

3. In the menu bar, select Transfer / To SDT 170 MD. 
The display is as follows. 
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Selecting the sub-menu “To SDT 170 MD”. 41A 

4. Click on the  icon to set the SDT 170 MD in Remote control mode. 
 

021 

Selection of the route to be transferred to the SDT 170 MD. 41B 

5. Select the routes to be transferred to the SDT 170 MD (maximum 128 
routes). 
To select more than one route, hold the Ctrl key down while clicking on the 
routes to be transferred.  

6. In the fields From and Until, select the corresponding date. 

7. Click on To SDT 170 MD button. 
 The SDT 170 MD automatically indicates Remote control for the duration of 

the transfer. Uploading is finished is displayed in the message box of the PC 
when the transfer is complete. Click OK. 

8. When data is transferred, set the SDT 170 MD in normal mode by 
clicking on the 

 
icon or on the Close button. 

Remote control is cleared on the SDT 170 MD screen. The route data have 
been transferred from the PC to the SDT 170 MD. This one can be used 
form measurement memorization.  
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11.5 TRANSFERRING DATA FROM THE SDT 170 MD TO 
DATAMANAGER  

Once the measurements done, they are to be transferred to the PC for analyzing. 
Data transfer from the SDT 170 MD unit to the PC is a simple procedure which 
includes three steps: 

● Synchronization of the SDT 170 MD with the DataManager. 

● Transfer of all existing data of the SDT 170 MD to the DataManager. 

● Updating of the database. 

Note: the SDT 170 MD must be connected to the PC.  

- By a serial link (RS232); see paragraph 4.3, page 24. 

- Or by a USB link; see chapter 15, page 99. 

Proceed as follows: 
1. Connect the SDT 170 MD to the PC (serial or USB port) and press on 

. 

2. Check the PC-SDT 170 MD connection, in accordance with 11.1. 

3. In the menu bar, select Transfer / From SDT 170 MD. 
The display is as follows. 

 
Selecting the sub-menu “From SDT 170 MD”. 42A 
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4. Click on the icon  to set the SDT 170 MD in Remote control mode. 

 
The screen for a data transfer from the SDT 170 MD to the PC.  42B 

5. Click on Start button to transfer data from the SDT 170 MD to the PC. 
The transfer of all the routes and their associated points, together with any 
new data that was saved to the SDT 170 MD, are moved to DataManager. 
At the end of the transfer the program displays Download finished. Click OK. 

6. When data is transferred, set the SDT 170 MD in normal mode by 
clicking on the 

 
icon or on the Close button. 

Remote control is cleared on the SDT 170 MD screen. The data are now on 
the hard disk of the computer. To display, select the route in Route/Open 
and view the data in Analysis. 

11.6 BACKUP/ RESTORE THE DATA  
11.6.1 Backup the database 
Two methods are available to backup the data of the database (BDD): 

● Via the application, menu File / Backup database.  

● Manually, via Windows Explorer.  
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Via the menu 
Proceed as follows: 

1. In the menu bar, select File / Backup database. 

 
Selection of the destination folder to be saved in. 11A 

2. In the window, click on  to select the destination folder and the 
name of the backup file. 

3. Click Create zip to complete the backup. 

Through Windows Explorer  
In Windows explorer open the DataManager (C: /Program files/SDT 
DataManager) folder and save the file called Data on any media (CD, DVD, 
USB, network, etc). 

11.6.2 Restoration of the data base  
To restore the data of the data base (BDD) two methods are available: 

● By the application, menu File / Incremental update.  

● Manually, through Windows Explorer.  

Through the menu 
Proceed as indicated in paragraph 11.6.3. 

Through Windows Explorer  
In Windows Explorer open the C: /Program files/SDT DataManager 
folder and paste the unzipped folder Data. Please note that this “paste” function 
erases the currently present data. 

Note: the Data directory can be pasted in any location, insofar as the data path is 
specified in Options/Parameter menu, Info tab, Route field. 
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11.6.3 Incremental update of the database  
Merging of the database currently used by the DataManager application with 
another compacted database (ZIP extension) obtained by an earlier backup 
operation (see paragraph 11.6.1). 

The resulting database is the one currently used by the DataManager application 
to which data from the compacted base will be added. Only data not existing in 
the base currently used by the application is transferred.  

Example of use of incremental update  
Repatriation of data from several PCs storing data from different SDT 170 MD 
data to a single PC. 

 
Repatriation of data coming from several PC to a single PC. D955 



11. Transferring the data 
 
 

75 

Operating method 
Proceed as follows for an incremental update of the database: 

1. Select File / Incremental update. 

 
Selection of the backup repatriation folder. 12A 

2. In the window, click on  to select the (ZIP extension) backup to be 
merged. Click OK to close the window. 

3. Click OK to launch the incremental update. 

 
The complete purging of the database is done by a specific sub-menu. 
See paragraph 13.5, page 96. 
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12 Processing and displaying data 

It is assumed that the measurement values have been transferred from the SDT 
170 MD to the hard disk of the PC as described in paragraph 11.5, page 71. 

During this step the SDT 170 MD need not be connected to the PC. These 
functions simply look up the databases stored on the hard disk of the PC. 

The display procedures are managed by the Analysis menu. 

240B 

The “Analysis” menu groups the measurements analysis procedures. M5  

12.1 SELECTING THE ROUTE TO DISPLAY  
1. In the menu bar, select the Route menu and click Open. 

2. Select the route to be viewed and click OK. 
 The active route is displayed at the bottom of the window. 

240B 

The active route is displayed at the bottom of the window. 240B 
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12.2 EDITING THE ROUTE REPORT 

 
Microsoft Excel must imperatively be installed on the computer to 
use the any printing possibilities. Other else, the export possibilities 
(ASCII, Mimosa or DBF) of the Route/Export menu must be used. 

Historical data stored in the DataManager software can be displayed as a screen 
report and printed if necessary. This display a list of all the points included in the 
current route along with their description, rank number and threshold values. 
Proceed as follows: 

1. In the menu bar, select the Analysis menu and click on Routes. 
Excel is opened and appears after a few delays as in the next figure.  

2. If necessary, edit from Excel the routes on the printer. 

 
Excel is automatically launched and displays data. 54A 

 
Modification of the displayed data does not have any impact on the 
database; modification is not taken into account while closing Excel. 
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12.3 DISPLAYING THE VALUES  

 
The Microsoft Excel application must imperatively be present on the 
PC for editing purposes. If not, export possibilities (ASCII, Mimosa or 
DBF) of the Route/Export menu will have to be used. 

This function is used for displaying data transferred from SDT 170 MD to the 
DataManager application. This history can then be analyzed point by point, for a 
defined period, for the selected route, as indicated in paragraph 12.1. Proceed as 
follows: 

1. In the menu, select Analysis and click Values. 
The Historical values window is displayed. 

 
Example of the Historical values window. 53A1 

2. In the Point name dropdown box, select the point of the current route 
to be analyzed. 

3. In the From and Until dropdown boxes, select the time period for the 
data to be viewed. 
The measurements, along with the time and date they were taken, are 
automatically displayed in the table. 

The Contact type column is only used for measurements recorded with the 
contact probe. It advises the operator of the frequency setting of the contact 
probe for that particular measurement. 

Column MFL Type is only visible and is used for measurements done with a 
mass flow sensor. It advises the operator on the sensor type used. 

Important: the colon right to Contact type may exist or not. A line with an X 
indicates that this value has been manually added (see § 12.3.2 – Adding a 
measurement).  

 
Example of a line with “X” at the right end of the line, indicating a manual entry. 53A2 

4. With the application Excel, it is possible to print the window thanks to 
the menu File / Send to Excel .  
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12.3.1 Erasing a measurement  
This function is used to erase data from within the Historical values window 
(previous figure). This is useful, for example, when a value is obviously 
erroneous. Proceed as follows: 

1. In the Historical values window select the cell or the line to be erased 
with the mouse. 

2. Press the Delete key on the keyboard. 
DataManager will ask to confirm the operation with the message “Are you 
sure to delete?”. Select the appropriate response to conclude the task. 

12.3.2 Adding a measurement  
This function is used to add data within the Historical values window when, for 
example, a measurement has been forgotten. Proceed as follows: 

1. In the Historical values window, right click on a line and select Add a 
new value. 

 
A right click on the table displays a pop-up menu. 53B 

2. Enter data to be added in the displayed window. 

 
The window when entering manually a new measurement. 53C 
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3. Click OK. 
The data is added in the table in chronological order. 

 
The new data are added to table (dark line). 53D 

 
Note the presence of a cross “X” at the right end of a line when data 
have been added manually. 

4. Close the window once the operation is finished. 

12.4 DISPLAYING ALARMS  
This function mainly displays, for the route selected as indicated in paragraph 
12.1, and for all the points of this route, alarms (in the form of icons), the values 
of threshold excesses, measurements with time-stamping as well as the units. 
Proceed as follows:  

1. In the menu, select Analysis and Alarms. 
The Alarm window appears as in the next figure. The values displayed 
depend on the parameters chosen by the operator.  

2. Select the sort options for display. 

 
The sorting options for display of alarms can be selected in the upper corner of the window. 51A 

Level: four possibilities are offered. 
- Warning: display the values which are over the first threshold level.  
- Alarm: display the values which are over the second threshold level. 
- Both: display the values which are over the first and the second 

threshold levels. 
- All: display all values. 

Date: displays the alarms selected between the dates From and Until. 
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Sensor: display the alarms: 
- for all types of sensors (choice All).  
- or only for the type of sensor selected in the dropdown box (choice Only 

one).  

Sorted by: sorts the table by point (number of points by ascending order), by 
date, by sensor or overrun (value of measurement higher than the value of 
the threshold defined).  

Files linked to:  
- Route: files linked to the route. 
- Point: files linked to the point. 

 To display a linked file, click on ▼ and, in the drop-down list, click on the 
file to be viewed. 

  Displayed information is immediately modified in the table of the results 
according to the options selected. 

 
The alarms window. 51C 

The columns specify the following information: 

-  Level: icon specifying the measurement alarm level. 
- Green: normal measure. 
- Yellow: warning. 
- Red: alarm. 
Reminder: the icons can be defined by the user (see paragraph Visual on 
page 95). 

-  Order: order number of measurement, “1” being the first measurement 
taken. 

- Point: name of the point (see paragraph 9.1.1, page 47, for the principle 
of definition of the name of a point). 

- Date / Time: time-stamping (date and time) of measuring the concerned 
point. 

- Sensor: type of sensor used for measurement. 

- Value: recorded value. 
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- Unit: unit of value of the preceding column. 

- Overflow: value of measurement higher than the value of the threshold 
defined. 

 
The asterisk present at the left of the column name recalls 
the sort criterion used. It is also possible to sort the table 
criterion-wise by clicking on the heading of the column 
regarded as sort key. 

3. In the present Excel application, it is possible to print the window by 
the menu File/Send to Excel.  

12.5 DISPLAYING GRAPHICS  
This function displays data of the active route, for the selected points on a 
maximum of 3 graphs. Each graph can display measurements of several points 
of the same type of sensor or 2 different sensors. 

 

 
Display of several points of the same type of sensor (high) or 2 different sensors (low). 52W-52X 

Proceed as follows: 

1. In the menu, select Analysis and click on Curves. 
The window Graphic representation is displayed.  
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2. Select the parameters. 

 
The sort options for display of the curves can be selected on the upper corner of the 
window. 52A 

Point name: select the point of measurement to be displayed. Several 
points of measurement can be simultaneously displayed by using the Add 
button.  
Sensor type: type of sensor to be displayed. Up to 2 sensors can be 
displayed together using the Add button. One sensor will be displayed on the 
left Y axis and the second on the right Y axis. 
Files linked to: click on the button ▼ to display the drop-down list of the 
files linked to the route and/or to the point and click on the selected file to 
launch the application for opening it. 
Date: displays the graph between the two selected dates (From to and Until). 
Note: if 2 sensors are displayed on the same graph, sole one can be sent to 
Excel (click right button). In this case, click “Clear all” and click “Add” to add 
the sole curve to be sent to Excel. 
Graph bar / Time graph: displays the data with curves or histograms. 

 

 
Displaying in the form of graph bar (below) or time graph (above). 52B – 52C 
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Work with: selects the graph, among the 3, which will receive data to be 
displayed when the Add button is clicked. 

Add: displays measurements of the point in the selected graph in the Work 
with box. 

Delete all: erases the entire graph. 

Show: displays (activated check box) or hides (absent check box) the 
corresponding graph. 

The graph then displays the selected data. Pointing the cursor on a point 
displays the data of the point (see the illustration below). 

 

Display of 
data relating 
to the point 
over which 
the cursor is. 

Example of a curve screen. 52D.  
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Note: holding the left button down and dragging the mouse selects a 
rectangle for zooming into a specific time period. Click right button View all 
to display the whole graph again. 

 

Encircle the 
area to be 
enlarged 

 

The area is 
enlarged. 

 

Returning to 
the normal 

size by right 
clicking. 

The zoom function is activated (top) by encircling the area to be enlarged. The result is the 
central illustration. To return to normal view, right click and select “Full view” (bottom). 52E - 52F – 52G 

3. Right-click the mouse to display the floating menu which provides the 
following functions: 

● Export to excel: opens the Excel application and automatically imports data 
there in graph and table format; the table being behind the graph.  
Caution: data can be imported only with one axis Y active. This function is 
active only if a graph is displayed.  

● Export all charts to Excel: open Excel application and automatically 
imports all data there in graph and table format; the table being behind the 
graph.  
Caution: data can be imported only with one axis Y active. This function is 
active only if a graph is displayed. 

● Printer setup: open the Windows “Printing Configuration” window. 
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A right click displays additional options. 52H 

● Print: to start printing of the graph. Before printing, maximize the graphics by 
clicking the icon in the top right corner. This function is active only if a graph 
is displayed. 

● Copy: copies in the Windows clipboard, the graph selected in BMP format. 
This function is active only if a graph is displayed. 

● View all: to display the complete graph (optimization of the axis). 

● Hide selection menu: displays or hides, the upper corner of the window 
Graphical representation, i.e. the parameters selection area. 

       The menus are displayed The menus are hidden 

     
By activating the function “Hide the selection menu”, the menus are hidden (right image). 52H – 52J 
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4. If necessary, print the window by right clicking and selection of Printer 
set up. 

 
The “Printer setup” function is accessible by a right click. 52K 

12.6 DISPLAYING INFORMATION OF A ROUTE  

 
This function requires Excel application on the PC. 

This function displays the characteristics of each of the points forming the route, 
entered in paragraphs 7.1, page 35 and 9.1.1, page 47.  

Proceed as follows: 
1. If the search relates to the current route, go directly to step 2. 
 If a route other than that displayed must be viewed, select in the menu bar 

Route/Open, click on the route to be displayed and on OK. 

2. In the menu bar, select Analysis and Route. 
The Excel application is launched. 

3. Search in the displayed data for information relating to the points for 
the route selected in step 1. 

 

 
Example of display of route information. 54A 

This data can be directly printed by Excel application.  
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Any modification of these values is not memorized once the Excel 
application is closed. To modify values with Excel, use the functions 
(Edit / Points / Global edit from Excel (see page 61) or Edit / 
Thresholds / Global edit from Excel (see page 56). 
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13 The Options menu 

Is gathers various sub-menus allowing the configuration of the program. 

 
Functions of the “Options” menu M6 

13.1 MENU LANGUAGE 
DataManager is a multi-lingual program. You may choose from up to ten different 
languages. Proceed as follows:  

1. In the menu, select Options and click on Language. 
The Language window appears as in the next figure.  

2. Select the language and click OK. 
The windows are immediately displaying the labels into the chosen 
language. The customer’s labels are, of course, not translated.  

 
The screen allowing the selection of the working language. 61A 
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13.2 MENU UNITS 
This window enables selection between the measuring units of the metric or 
imperial system. 

1. In the menu, select Options and click on Unit. 
The Unit selection window appears as in the next figure.  

    
The window enabling selection of units in metric or imperial system. 62A 

2. Select the type of units (Metric or Imperial) in which the data will be 
displayed.  
The table lists the units for each type of measurement but they cannot be 
edited except for temperature. For selecting the type of units, double click in 
the unit box in order to successively display the  button and select the unit 
in the drop-down list. 

      

For the temperature, click in the cell and then on the  button and select the unit.  62B – 62C 

3. Click Close. 
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13.3 MENU PARAMETERS 
1. In the menu, select the Options and click on Parameters. 

The Parameter window appears.  

2. Select one of the four tabs. 
Refer to paragraphs below for the description of each of the tabs.  

13.3.1 Info 
This tab defines the company name which will appear on all the reports and 
graphs as well as the database path of the DataManager application. 

Company name: every report and graph displays the company name shown in 
the Parameter / Info window. To change the company name label, modify that 
field. 

Data path: display the location of the data memorized by DataManager. To 
modify this location, click on the  button and select the right folder.  

 
The tab which defines the name of the firm printed on the reports and graphs and the 
localization of the data memorized by the software. 63A 

13.3.2 Security 
When DataManager is first installed, a factory set security password is already 
encrypted SDT. This password can be modified after installation by selecting this 
tab. 

Click Change. Enter the old password in the Old password field and enter the 
new password in the New password field. Confirm by entering the new password 
once again in the Confirm field. Click Apply to use the new password.  
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The tab allowing the definition of the password. 63B-63C 

Users who know the password have 100% access to the software. Users who do 
not know the password will be able to view the data, but not modify it.  

13.3.3 Com/Port 
This tab allows the selection of the communication port on the PC in use for the 
SDT 170 MD. 

Enter the COM port number of the PC to be used. The other displayed data can 
not be modified. 

 
The tab allowing the definition of the communication port. 63D 
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13.3.4 Visual 
This window defines icons which will be displayed in the window Analysis/Alarm. 

 

 
Example of the selection of icon and its application in the Analysis / Alarm window. 63H-63J 

Proceed as follows: 

1. In the drop-down list, select the Alarm, Warning or Normal threshold 
for which the icon will be defined. 

 Reminder: Warning corresponds to the first alarm threshold and Alarm to the 
second threshold (highest). 

     
Choice of icon. 63F-63G 

2. Click on the Select a picture button and on the desired icon. 

3. If necessary, proceed as indicated in points 1 and 2 for the other 
thresholds. 

4. Click Close to confirm the choices. 



 
 

13.4 DETECT SDT 170 MD 
This tab allows confirming the correct connection between the SDT 170 MD 
device and the PC. When this function is selected, the status bar at lower side of 
the screen displays the name of the current route (here ROUTE01), the type of 
data logger (here SDT 170 1.40 – MD) and COM Port number (here Com5). 

If no SDT 170 MD is detected a message No SDT 170 MD will appear. 

 
 

 
N

Information for a correct (top) or incorrect 
SDT 170 MD.  

13.5 EMPTY DB  
This tab allows to erase or to purge o
the hard disk.  

Once the maximum date of erasure is
application will erase historical measu
route, up to the date indicated in the fiel

 
Warning: once the Purge bu
definitely be erased and can
from a back-up disk. 

The windows allowing the erasing of the old 

A message asks for confirmation befo
Yes to erase the database or on No 
accomplished, a window displays Data 
o SDT 170 MD detected
9

l

r

 

r

b

 SDT170 MD detected 
Com Port number used
6 

 
(bottom) connection between the PC and the 

64B-64C 

d data from the current route present on 

 defined, click Erase. The DataManager 
ements for the oldest data found in the 
d Purge until. 

tton is pushed, the measurements will 
only be retrieved by means of restoring 

 
data from the current route. 65A 

e final erasing of the database; click on 
to abandon the erase procedure. Once 
ase erased. 
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14 Error messages 

14.1 MAJOR CAUSES OF FAULTY CONNECTION  
14.1.1 Reason 1 
By default, DataManager is configured to use the COM1 port. If this on is already 
used by an equipment (mouse, etc.), an error message is displayed. 

Method using the DataManager application 
Modify the port number through the Options/ Parameters / Port COM (see 
paragraph 13.3.3). 

Method not using the DataManager application 
The COM Port number can also be modified directly by the ini file of the 
DataManager application. Proceed as follows: 

1. In the work station, open Program files folders and SDT DataManager. 

2. Double-click on the file labeled DataManager.ini (type of file: 
Configuration settings). 

3. Modify the line Com No=1 in any other port number (for example 2). 
Close this file with saving the changes. 

4. Reopen DataManager. 

14.1.2 Reason 2 
If the message “COM port 1 does not exist” is displayed, select the 
correct port that was used to connect the SDT 170 MD (see paragraph 4.3). This 
message is also displayed if the program is run twice. “COM port 1 is 
already open by a device”. 
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14.2 OTHER CAUSES OF ERROR 
14.2.1 Absent or badly connected cable 
Connection between the PC and the SDT 170 MD is absent or incorrect. Check 
the cable, the correct positioning of the connectors. Click OK, close the 
application before starting it again or select the Options/Detect SDT 170 MD 
menu. If the problem is not solved, execute the steps indicated in paragraph 
14.1. 

14.2.2 The SDT 170 MD is not connected 

SDT 170 MD is not activated. Push the on/off button  of SDT 170 MD. Click 
OK, close the application before starting it again or selecting the Options / Detect 
SDT 170 MD menu.  
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15 USB-RS232 Converter 

When the PC on which the SDT 170 MD will be connected does not have 
(RS232) serial port, the communication will be done through a USB port.  

15.1 CONFIGURATION 
Once the unit is complete, the system will appear as follows: 

 

 

USB port of the PC 
 

Converter 
RS232 to USB optional 

Plug ended cord RS232 
provided 

Elements in a connection between the SDT 170 MD and the PC by USB cable and 
converter. D960 
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15.2 INSTALLATION OF THE SOFTWARE 
Step Illustration Action 

1. 
 

Check that the cable connecting the PC to the 
USB-RS232 converter is disconnected before 
launching the installation procedure of the 
application. 

2.  On the PC, decompact Driver.zip USB 
application. 
This application can be downloaded on the 
following ftp site: 
ftp://sdt.be/pub/SDT170%20Software/USB  

3. 

 

Double click on the USB DRIVER.exe icon to 
launch the application. 

 

4. Click on Next to launch the installation procedure. 

5 Click on Finish to finish the installation procedure. 

6.  Restart the PC if the prompt is displayed. 

15.3 CHECKING THE PRESENCE OF THE USB-RS232 DRIVER  
Step Screen Action 

1 

 

Depending on the type of display on the 
Start menu, use one of the following two 
methods: 
- Standard Start menu: right-click on the My 
computer icon on the desktop. 
- Start menu: select Start / My computer. 
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2 

  

In both cases, right-click and select 
Manage. 

3 

 

Click on Device manager. 

4 

 

Click on the + sign in Ports (Com and LPT). 

5 

 

Double-click on the icon for the installed 
USB converter. 

6 

 

In the window displayed, click on the Port 
settings tab. 

7 

 

Define the parameters as follows (by 
clicking on the drop-down list located on the 
right of each field): 
Bits per second: 9600. 
Data bits: 8. 
Parity: none. 
Stop bits: 1. 
Flow control: none. 

8  Click on the OK button to record the data, 
close the window and return to the welcome 
screen (step 2 in this paragraph). 
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NB: if, after a further communication test, no communication is possible between 
the SDT 170 MTT and the PC, you must modify the PC’s communication port. 
Proceed as follows:  

9  Carry out steps 1 to 7 described above. 
10 

 

In the window displayed (illustration 
opposite), click on the Advanced button.  

11 

 

In the window displayed (illustration 
opposite) select another COM port. 

12 

 

Click on the OK button to record the data, 
close the window and return to the welcome 
screen (step 2 in this paragraph). 

13  Carry out a new transmission test. If the test 
is still not conclusive, redo steps 9 to 12 
above until the right COM port has been 
found. 

15.4 CHECKING OF PC- SDT 170 MD CONNECTION 
Step Illustration Action 

1.  Push the on/off button  of the SDT 170 MD 
to start the apparatus. 

Check that the PC cable to the USB-RS232 
adapter is always connected to the PC. 

Connect the end of the (RS232) series cable to 
the SDT 170 MD. 

2. 

 

Double click the icon of the DataManager 
application.  
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3. 

 

The Detection of the SDT 170 MD window is 
displayed for a few seconds. 

Note: if this indication is replaced by an error 
message, refer to paragraph 15.5. 

4. 

 

The application is launched. 

At the bottom of the screen, the following 
indications are displayed: 

-  DataManager 2.0: version number. 
-  SDT 170 1.40 MD COM X: “X” being the 

communication port number used (see step 
9, paragraph15.3. 

These indications confirm the correct 
connection between the application and the 
SDT 170 MD. 

5.  The DataManager application can be used with 
its transfer functionalities. 

15.5 IN CASE OF USB-RS232 COMMUNICATION PROBLEM 
Proceed as follows: 

1. Check that the SDT 170 MD is on.  

2. If so, shut down the SDT 170 MD. Close the DataManager application. 

3. Check that the connection between the PC and the adapter is correct. 

4. If yes, modify the configuration parameters of the configuration in the 
following way: 
a. With the explorer, access the following folder: C: /Program 

Files/SDT DataManager. 
b. Double click on the DataManager.ini file. 
c. Modify the numerical value of the line to obtain Timer = 10. 
d. Modify the numerical value of the line to obtain  
  Unlock Timer = 10. 
e. Select File/Save. 

5. Switch on the SDT 170 MD. Relaunch the DataManager application. 
Connection should be correct with the display of the Detection 
SDT 170 MD window in accordance with point 4 of paragraph 15.4. 
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16 Index 

Absent cable, 98 
Adding points in Excel, 64 
Advanced, 102 
Aim of the application, 9 
Alarm 

Defining the icon, 95 
Displaying, 81 
Icon, 95 
Icons, 82 
Point of a route, 49 

Alarm - modifying 
Point of a route, 55 

Alarm high 
Point of a route, 50 

Alarm levels 
Viewing levels, 20 

Alarm levels 
Viewing levels, 21 

Alarm thresholds 
Define, 15 
Global edition, 56 
Managing the alarm thresholds 

separately, 55 
Modifying several points, 56 
Modifying with Excel, 56 
Viewing thresholds, 20 

Alarms 
Menu, 31 
Viewing thresholds, 21 
Visualiser les seuils, 20 

Analysis, 31, 77 
Alarms, 31, 81 
Curves, 31, 83 
Route, 31 
Routes, 88 
Values, 31, 79 

Application DataManager See 
DataManager 

ASCII, 40 
Author of the route, 36 
Back-up 

Database, 72 

Backup database, 29 
Badly connected cable, 98 
Bargraphe, 20 
Base de Database 

Restore, 73 
Bits per second, 101 
Com, 102 
COM, 26, 94 

Used com port number, 96 
COM 1, 24 
COM port, 102 
Comment 

Point of a route, 48 
Company, 93 
Connection 

Major causes, 97 
Converter 

USB-RS232, 99 
Copying, 60 
Create 

Point of a route, 47 
Creating 

A new route, 35 
Curve 

Graphics, 84 
Curves 

Menu, 31 
Danger/Alarm, 49 
Data 

Transfer to PC, 71 
Data bits, 101 
Data path:, 93 
Database 

Backup, 29 
Back-up, 72 
Clear, 96 
Incremental update, 29 
Path, 93 
Update, 74 

DataManager 
Exit, 28 
File "ini", 26, 103 
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Ini, 26, 103 
Installation, 23 
Installing the application, 23 
Lauching the application, 25 
Menus, 29 
Programm file, 23 
Required configuration, 23 
Setup.exe, 23 
Uninstall the application, 24 
Version number, 27, 28 

DataManager.ini, 26, 103 
Date, 69 
DBF, 40 
Default 

Connection, 97 
Delating 

A route, 37 
Delete, 30 

Point of a route, 52 
Points in Excel, 63 

Description 
Point of a route, 48 

Description of the route, 36 
Device manager, 101 
Display 

Graph bar, 84 
Graphics, 84 
Sorted, 82 

Display language, 91 
Displaying points in Excel, 61 
Duplicate, 58 
Edit, 30 

Parameter, 30 
Point of a route, 52 
Points, 30, 45, 47 
Points –Global edition, 61 
Thresholds – Global edition, 56 
Thresholds – Single edition, 55 

English, 91 
Erase, 31 
Error messages, 25 
Errors 

Messages, 97 
Errors mesages, 97 
Excel 

Adding points, 64 

Delete points, 63 
Displaying the points, 61 
Export graph, 86 
Modifying alarm thresholds, 56 
Modifying points, 62 

Exit, 28, 29 
Export, 30 
Export graph, 86 
Exporting 

ASCII format, 40 
DBF format, 42 
Mimosa format, 41 

Exporting a route, 40 
File, 29 

Backup BDD, 29 
BAck-up database, 72 
Exit, 29 
Incremental update, 74 
ini, 26 
Linked files, 30 
Merging BDD, 29 
Senf to Excel, 29 

File ini 
Datamanager, 26, 103 

Files 
Linked files, 30 

Flow control, 101 
From SDT170, 31 
Global edition 

Alarm thresholds, 56 
God/Bad, 50 
Graph bar, 84 
Graphics 

Curve, 84 
Displaying, 83 
Zoom, 86 

Help, 28 
About, 33 
Content, 33 

Icon 
Alarm, 95 
Defining, 95 

Icons 
Alarm, 82 

Imperial, 92 
Incremental update, 29 
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Database, 74 
Information company, 93 
ini, 26 

Datamanager, 26, 103 
Inline help, 28 
Insert 

Point of a route, 47 
Installing DataManager, 23 
Language, 91 

Choosing the language, 91 
Lauching DataManager, 25 
Launching the application, 12 
Level 1, 15 
Level 2, 15 
Linked files, 30, 39 

Point of the route, 47 
Linked files to a route, 38 
Low 

Point of a route, 50 
Main screen, 27 
Measurement 

Adding a measurement, 80 
Clear, 96 
Erasing a measurement, 80 

Measurement curves 
Viewing, 20 

Measurements 
Viewing curves, 20 

Measurements 
Deleting, 52 

Measurements 
Displaying, 79 

Measuring 
Définir le nom, 14 

Measuring point 
Alarm thresholds, 15 
Create the points points, 14 
Define the alarm thresholds, 15 

Measuring points 
Name, 14 

Memory 
Purge the memory of the SDT 

170 MD, 68 
Menu 

Analysis, 77 
File, 29 

Menus, 29 

Method Warning/Alarm, 57 
Metric, 92 
Mimosa, 40 
Modifying points in Excel, 62 
Moving down a point of a route, 53 
Moving up a point of a route, 53 
Name 

Point of a route, 47 
New, 30 
No cable, 25 
Number of the route, 27 
Open, 30 
Opening 

A route, 36 
Options 

Clear the Database, 96 
DB purge, 32 
Detect SDT 170 MD, 32, 96 
Language, 32, 91 
Parameters, 32, 93 
Parameters-Com/Port, 94 
Parameters-Info, 93 
Parameters-Security, 93 
Parameters-Visual, 95 
Unit, 32 
Units, 92 

Parity, 101 
Password 

Default, 93 
Enter, 13, 19, 28 
Modify, 93 

Paste, 59 
Pasting, 60 
PC 

Connection error with SDT 170 
MD, 68 

Transfering data to SDT170MD, 
17 

Point ID, 56 
Point of a route 

Modifying Excel, 62 
Moving up, 53 
Renaming, 53 
Sensor type, 49 

Points 
Insert, 47 

Points of a road 
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Generalities, 43 
Points of a route 

Adding in Excel, 64 
Alarm, 49 
Alarm - modifying, 55 
Comment, 48 
Copying/pasting between 2 

routes, 60 
Copying/pasting in a same route, 

58 
Creating, 47 
Delete in Excel, 63 
Deleting, 52 
Deleting measurements, 52 
Description, 48 
Displaying in Excel, 61 
Edit, 52 
Global management, 61 
Individual management, 45 
Insert, 47 
Linked files, 47 
Low, 50 
Main menu, 45 
Modifying alarm thresholds Excel, 

56 
Modifying the alarm thresholds of 

several points, 56 
Moving down a point, 53 
Name, 47 
Position, 47 
Printing, 54 
Threshold 2, 49 
Threshold low, 50 
Warning, 49 

Points of route 
Managing alarm thresholds, 55 
Threshold, 50 
Threshold 1, 49, 50 

Port 
COM, 102 

Port COM, 26 
Modify, 94 

Port does not exist, 97 
Port xx doesn’t exist, 25 
Ports (Com and LPT), 101 
Position 

Point of a route, 47 
Principle of use, 9 
Printing 

A route, 39 
Printing a point of a route, 54 
Program Files, 93 
Quick familiarisation, 11 
Remote control, 17 
Rename, 30 
Renaming 

A route, 37 
Renaming a point of a route, 53 
Restore 

Database, 73 
Route, 30 

Author, 36 
Characteristics, 21 
Create the points, 14 
Creating a new route, 35 
Creating a route, 13 
Defining the points, 43 
Delete, 30, 37 
Description, 36 
Display characteristics, 21 
Displaying measurements, 79 
Displaying the values, 79 
Exporter, 30 
Exporting, 40 
Linked files, 30, 38 
Menu, 31 
Name, 36 
New, 30, 35 
New route, 35 
Number, 27 
Open, 30, 36 
Parametring, 13 
Print, 39 
Rename, 30, 37 
Selecting the route to display, 77 

Route ID, 56 
Routes 

Copying/pasting between 2 
routes, 60 

Copying/pasting in a same route, 
58 

Displaying information, 88 
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Edit informations, 88 
Transfer to PC, 71 
Transfert from the PC, 69 

RS232, 23, 99 
Establishing the link, 18 
Etablishing the link, 16 

SDT 170 MD 
Date, 69 
Not connected, 98 
Purge the memory, 68 
Receiving data from PC, 67 
Synchronization with PC, 69 
Time, 69 
Tme stamping, 69 
Transfering data to PC, 17 
Transferring routes to PC, 71 
Transferring the routes from the 

PC, 69 
Verifying connection to PC, 68 

SDT 170 MD not connected, 25 
Sensor 

Point of a route, 49 
Sensor type, 57 

Point of a route, 49 
Serial port See RS232 
Setup.exe, 23 
Stop bits, 101 
Synchronise, 31 
Synchronization 

With the SDT 170 MD, 69 
Threshold 

Warning/Alarm, 49 
Threshold 1, 57 

Point of a route, 49, 50 
Threshold 2 

Point of a route, 49, 50 
Threshold methode 

God/BAd, 50 
Thresholds 

Viewing levels, 21 
Time, 69 
Time graph, 20, 84 
Time stamping, 69 
To SDT170, 31 

Transfer 
From SDT 170 MD, 31, 71 
Synchronization, 69 

Transfering data to SDT 170 MD 
Receiving data from PC, 67 

Transferring data to PC, 71 
Transferring routes to PC, 71 
Transferring the routes from the 

PC, 69 
Transfert, 31 

Delete, 31 
From SDT 170 MD, 31 
Main menu, 67 
Synchronise, 31 
To SDT 170 MD, 69 

Uninstall DataManager, 24 
Units, 92 
USB, 24, 99 

Communication problems, 102, 
103 

Establishing the link, 18 
Etablishing the link, 16 

USB-RS232 Converter, 99 
Values 

Displaying, 79 
Menu, 31 

Version number, 27, 28 
Warning 

Point of a route, 49 
Warning/Alarm, 57 
Window 

Cascade, 32 
Close all, 32 
Mosaic, 32 

Windows 2000, 23 
Windows 95, 23 
Windows 98, 23 
Windows NT, 23 
Windows XP, 23 
Working language, 12 
Zoom 

Enlarge, 86 
Graphics, 86 
Reduce, 86 
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